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Answers 

1. [Q] How do I get started with EmNOC? 

To get started with EmNOC first you need to register your details and validate your account. 
 
When you login for the first time you will be prompted to create a domain.  A domain represents a 
network you want to manage.  You will then be prompted to download and install a probe for each 
domain you create.  The probe is installed and run on a single device in the domain and will detect all the 
IP devices visible to it eg servers, workstations, printers etc.  You can review the discovered devices for a 
particular domain on the Inventory page. 

When you have discovered all your devices you will need to review them and identify those you want to 
monitor.   First you need to enable management for each of the nominated devices.  To manage a device 
you have a choice of WMI, SNMP or SSH.   Once your devices are manageable you can enable monitoring 

mailto:Info@emnico.com
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and the probe will start to collect data and generate alerts for and device which requires attention.  You 
may want to review the initial set of alerts and decide which ones you are interested in and which ones 
you are not interested in e.g. Device Up/Down for unmonitored devices. 

You can always take a look at the help pages which describe each page in more detail. 

2. [Q] What are the system requirements for EmNOC? 
 
[A] R3.2.x is available for running on Microsoft Windows based machines. A linux version will be available 
soon.  

We have tested EmNOC on Microsoft Windows 2000, XP, Vista.  

We have tested with browsers IE 7, IE8, Firefox 3. 

  

3. [Q] Is EmNOC really free and not a trial version? 

 [A] Yes it is completely free, however, there will be a monthly charge should you decide to increase the 
amount and/or frequency of collected data.   
 
 Note: There is no other limit on functionality. There are no advertising screens, popups or other forms of 
"nagging".  
  

4. [Q] Can I run EmNOC on the same machine as IIS or Apache? 
 
[A] Yes you can, but you must ensure that the EmNOC does not use the same port number as is being 
used for the IIS, Apache or other web server.  

By default EmNOC runs on port 8080. Use the options menu from the tray icon to change which port 
number is used. You may need to restart the service after performing this operation.  

Use the tray icon to run the browser to connect to EmNOC with the correct port number.   
  

5. [Q] How can I get more information from my windows server? 
 
[A] You can enable some optional Microsoft software on the server that will give EmNOC more detailed 
information.  

More details can be found in this How-To.  

Once completed, you can simply do a re-discover and EmNOC will be able to view, explore and monitor 
administrative information.  
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6. [Q] Does EmNOC install any software on the machines I wish to look at or monitor? 
 
[A] No  

Some manufacturers call this agent-less. EmNOC only accesses information that is already 
available on the machines it discovers.  
     

7. [Q] Why can't I start or stop the EmNOC service from the EmNOC tray-icon menu? 
 
[A] You need to use an administrator account to start or stop Windows services; if you try to use these 
commands, Windows will prompt you to input an administrator password. If you don't have one, it will 
not be able to start or stop the service. [Back to the top]  
 

8. [Q] I don't see the EmNOC tray icon ? 
 
[A] If you do not see the EmNOC system-tray icon after installing EmNOC, it may be because you do not 
have the Microsoft .NET framework (V2.0) installed. This is required for the EmNOC system-tray icon to 
run, and is available through Windows Updates, or directly from Microsoft at  

http://www.microsoft.com/downloads/details.aspx?FamilyID=0856EACB-4362-4B0D-8EDD-
AAB15C5E04F5&displaylang=en 
 

9. [Q] Do you support 64-bit Microsoft Windows platforms? 
 
[A] 64-bit Microsoft Windows platforms are supported.  The only limitation is that it requires the 32-bit 
Java runtime. 

 

10. [Q] Why is chipset sometimes incorrectly reported on machine where probe is installed? 
 
[A] This is an SNMP issue, the Windows SNMP agent appears to return "Intel" as the CPU identification 
regardless of the actual CPU type. As a workaround Use EmNOC GUI and enable the related device via 
WMI Management protocol.   Chipset will then be reported correctly. 
 

11. [Q] Why is there no inventory shown for some of my devices? 
 
[A] Devices running on Vista Operation System(64-bit)  when managed via SNMP only return 64-bit 
application and not 32-bit applications.  As a workaround, use EmNOC GUI and manage related devices 
via WMI Management protocol.   All devices will then be correctly returned. 
 
 

12. [Q] Can I install my probe on another machine? 
 
[A] You can achieve this by using the ‘Move Probe’ option on the Domains page.  First you must ensure 
that your probe is no longer running i.e. it is stopped.  Then using this option, download the probe to your 
new machine and install it as normal. 
 

http://www.microsoft.com/downloads/details.aspx?FamilyID=0856EACB-4362-4B0D-8EDD-AAB15C5E04F5&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=0856EACB-4362-4B0D-8EDD-AAB15C5E04F5&displaylang=en
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13. [Q] Why does remote exec seem to always return errors on an XP based machine? 
 
[A] There can be three reasons: 
 
The first is to ensure the credentials for the machine are correct. On the inventory tab, select the device 
and under the Action menu select Remote Access. Select the WMI tab and enter a valid user name and 
password of a user in the Administrators group. Always provide the domain in the user name. If the user 
name is local to the machine then provide the machine name. So, a local user in the administrators group 
on machine PCA would then be entered as PCA\username. 
 
The second reason could be the device is in a workgroup. If it is in a work group, then “Simple File 
Sharing” must be disabled. To do this, open Windows File Explorer and select  Tools->Folder Options.  On 
the View tab, scroll down to the option “Use simple file sharing” and uncheck the box. Click Apply. 
 
The third reason is the device is running XP Home. Remote execution is not supported on XP Home. 
 
 

14. [Q] Why does remote exec seem to always return errors on a Vista based machine? 
 
[A] There can be two reasons for this.  
 
The first is to ensure the credentials for the machine are correct. On the inventory tab, select the device 
and under the Action menu select Remote Access. Select the WMI tab and enter a valid user name and 
password of a user in the Administrators group. Always provide the domain in the user name. If the user 
name is local to the machine then provide the machine name. So, a local user in the administrators group 
on machine PCA would then be entered as PCA\username. 
 
The second reason could be the device is in a workgroup. If it is in a work group you need to ensure it is in 
the same workgroup as the device running the probe and then the LocalAccountTokenFilterPolicy needs 
to be set. This can be done as follows… 
 
Click on the following link using IE8 on the machine concerned http://go.microsoft.com/?linkid=9646956 

Or, if you prefer to perform the steps manually then… 
 
Click Start, click Run, type regedit, and then press ENTER.  

1. Locate and then click the following registry subkey: 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System  

2. If the LocalAccountTokenFilterPolicy registry entry does not exist, follow these steps:  

c. On the Edit menu, point to New, and then click DWORD Value.  

d. Type LocalAccountTokenFilterPolicy, and then press ENTER.  

 Right-click LocalAccountTokenFilterPolicy, and then click Modify.  

 In the Value data box, type 1, and then click OK.  

 Exit Registry Editor 

 

http://go.microsoft.com/?linkid=9646956


All rights reserved – Emnico Technologies Limited 
Company No. 6390125, VAT No. 922 1885 25 

5 of 11    

   

15. [Q] What ports need to be opened on my company firewall for the probe to export the data to the 

portal? 

 

[A] The EmNOC probe does not normally need any changes to be performed on the small and medium 

sized business firewalls.  

 

This is because the probe only uses ports that are normally used for “web” traffic. So, the HTTP and HTTPS 

ports of 80 and 443 need to be open so that the probe can get configuration information from the portal 

and post network information to the portal. 

 

 All customer data is transmitted in an encoded format using SSL. 

 

Some businesses use web proxy and the EmNOC probe supports this configuration. Once the probe has 

been downloaded and installed, the proxy settings can be changed via the tray icon for the probe.  

 

16.  ώvϐ ²Ƙȅ ŘƻƴΩǘ L ǎŜŜ CPU data for some of my SNMP devices? 

 

[A] Not all SNMP devices support all of the standard MIBS. 

 

EmNOC uses the HOST_RESOURCES MIB to retrieve and display information about CPU, disks and 

memory.  If your device does not support this or it has not been enabled then you will not see any data.  
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How-To: Enable SNMP on Windows XP Machines 

 

You can enable some optional Microsoft software on the server that will give EmNOC more detailed information.  

You should only do this if your computers are not connected directly to the internet. As long as there is a 
router/firewall between your machines and the internet, then you can follow these steps.  

To do this, log in as the Administrator on the machine concerned, select "Control Panel", then "Add/Remove 
Programs", select the option "Add/Remove Windows Components" and you should see a window similiar to the 
one below.  

 

In the list select "Management and Monitoring Tools" followed by "Next". Windows will install the optional 
software. If you do not have a copy of Windows on your harddrive, you may be prompted for your media during 
the install process.  

Now on the control panel open up the tab that says "Windows Firewall" and select the exceptions tab...  
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Select "Add Port..." and..  

 

in the fields enter "SNMP" as the name of the port, "161" as the port number and "UDP" rather than "TCP" as the 
protocol. Then select OK.  
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Next, perform a right-click on "My Computer" and select "Manage". Open up the "Services and Applications" tree 
so that the "Services" option can be selected and displayed.  

 

Find the "SNMP Service" in the services list and double-click.  
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Select the "Agent" tab and ensure all the check boxes are selected. The select "Apply".  

This has now enable SNMP on this computer. If you (re)-run discovery within EmNOC it will provide you with 
extensive information.  

See also the following KB articles from Microsoft.  

¶ Enabling SNMP on Windows 2000 (KB315154) 
¶ Enabling SNMP on Windows Server 2003 (KB324263) 

How to configure Network Security for the SNMP Service in Windows Server 2003 (KB324261) 

 

 

  

http://support.microsoft.com/kb/315154
http://support.microsoft.com/kb/324263
http://support.microsoft.com/kb/324261
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How-To: Enable WMI on Windows Machines 

 

You can enable some optional Microsoft software on the server that will give EmNOC more detailed information.  

You should only do this if your computers are not connected directly to the internet. As long as there is a 
router/firewall between your machines and the internet, then you can follow these steps.  

Connecting to WMI on a Remote Computer 

Active Directory Environments 

Use the Group Policy Editor to edit the policies on the organizational units (OUs) containing the computers on 

which you want to perform the assessment.  For instructions on how to use the Group Policy Editor, go to 

http://support.microsoft.com/kb/307882 [ http://support.microsoft.com/kb/307882.aspx ] .  

1. Using the Group Policy Editor, click Computer Configuration, click Windows Settings, click Security 

Settings, click Local Policies, and then click Security Options.  In Network access: Sharing and 

security model for local accounts, click Classic – local users authenticate as themselves. 

 

2. Using the Group Policy Editor, click Computer Configuration, click Administrative Templates, click 

Network, click Network Connections, click Windows Firewall, and then click Domain Profile. 

 

3. In Windows Firewall: Allow remote administration exception, click Enabled. In Allow unsolicited 

incoming messages from, type the IP address or subnet of the computer performing the 

inventory. 

 

4.  In Windows Firewall: Allow file and print sharing exception, click Enabled. In Allow unsolicited 

incoming messages from, type the IP address or subnet of the computer performing the 

inventory. 

After saving the policy changes, you need to wait for the policy settings to be applied to the client computers, 

which can take up to two hours. 

Workgroups and Windows NT 4.0 Domains 

For computers in a workgroup, you need to manually configure each computer. For computers in a Windows NT 

4.0 domain, use logon scripts to configure the Windows Firewall exceptions. 

1. Using the Local Security Policy tool available from the Administrative Tools menu of the computer 

to be inventoried, click Security Settings, click Local Policies, and then click Security Options. In 

Network access:  

Sharing and security model for local accounts click Classic – local users authenticate as 

themselves.  

http://msdn.microsoft.com/en-us/library/aa389290%28VS.85%29.aspx
http://support.microsoft.com/kb/307882
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2. To enable the remote administration exception, manually run the following command, or run it 

from a logon script on each computer:  

netsh firewall add portopening protocol=tcp port=135 name=DCOM_TCP135 

3. To enable the file and printer sharing exception, manually run the following command, or run it 

from a logon script on each computer:  

netsh firewall set service type = fileandprintmode = enableprofile = all 

 

Workgroups and Windows Vista UAC 

[Q] Can I connect to a remote PC running on Windows Vista or Windows 7 with UAC enabled in it? 

 

[A] Yes you can, provided you change a setting in the registry of the Vista PC to enable this. Open Regedit.exe, 

open the location HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\system, add the DWORD value 

name LocalAccountTokenFilterPolicy, and set its value to 1. 

 


